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Chapter 1. Introduction

Inversion of seismic data to Acoustic Impedance (AI) is usually seen as a 
specialist activity. In site of the publicised benefits, inverted data are only 
used in a minority of cases. To help overcome this obstacle, this algorithm 
which is quick and easy to use, can increase the use of inversion 
technology. Seismic Coloured Inversion (SCI) performs significantly better 
than traditional fast-track methods such as recursive inversion, and 
benchmarks well against unconstrained sparse-spike inversion and gives 
broadly equivalent results. Sophisticated inversion methods are time 
consuming, expensive, require specialists and not performed routinely by 
the Interpretation Geophysicist, whereas SCI is rapid, easy to use, 
inexpensive, robust and does not require expert users.

With the inclusion of de-trend and normalisation functionality within SCI, 
geophysical meaning can now be assigned to the observed amplitude 
changes in the derived impedance volumes. This can be very powerful, 
particularly with 4D projects.

Once the SCI operator has been derived, it can be simply applied using the 
convolution function within the software. In this way, inversion can be 
achieved within hours since the volume data do not have to be exported 
to another package.

Traditional fast-track methods for band-limited inversion to relative AI are 
prone to error because no account is taken of the seismic wavelet or 
calibration to the Earth. Although more sophisticated techniques such as 
sparse-spike inversion take account of these factors, specialist skills are 
required.

SCI takes into account the seismic wavelet and is consistent with log data. 
With this technique, it is now possible to routinely invert any dataset 
within hours and establish a base case against which more sophisticated 
techniques must be judged.

SCI enable the rapid inversion of 3D and 4D data. A single convolution 
inversion operator is derived that optimally inverts the data and honours 
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available well data in a global sense. In this way, the process is 
intrinsically stable and broadly consistent with known AI behaviour in the 
area. Construction of the operator is a simple process and implementation 
can be readily performed within the processing module. As an explicit 
wavelet is not required, other than testing for a residual constant phase 
rotation as the last step, this removes an inherently weak link that more 
sophisticated processes rely on.
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This chapter provides some background information and theory to Seismic 
Coloured Inversion (SCI) and Seismic Spectral Blueing (SSB). The focus of 
this chapter will be Seismic Coloured Inversion. However, the spectral 
analysis and spectral shaping techniques discussed within also apply to 
Seismic Spectra Blueing.
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2.1. Basics

Let us first consider the basis of Seismic Inversion. Acoustic Impedance is the product of interval velocity 
and density and is normally represented by the equation:

AI(j) = Vp(j) * p(j)

where Vp is p-wave velocity

and p is density

Seismic reflections are given by the change in the Acoustic Impedance of the layers and are represented by 
the equation

RC(j) = ( AI(j +1) - AI(j) ) / ( AI(j + 1) + AI(j) )

Now the normal assumption is that the seismic trace is considered to be a primary only reflectivity model 
convolved with the seismic wavelet which is summed with some uncorrelated noise and can be represented 
by the equation:

S(t) = R(t) * W(t) + N(t)

Figure 2.1. Seismic Method and Inversion

 
The figure above is a pictorial representation of the convolutional model. So, in simplistic terms the process 
of moving rocks on the left to seismic on the right is termed the seismic method. On the left we have rock 
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property Acoustic Impedance (AI). So, moving left to right changes in AI at layer boundaries result in 
normal incident reflection coefficients. Everywhere there is a reflection coefficient it is replaced by a wavelet 
which is centred and weighted by the reflection coefficient. These individual wavelets are summed and 
uncorrelated noise is added to generate the seismic trace.

The process of seismic inversion takes us in the opposite direction trying to determine the Acoustic 
Impedance of the individual rock layers.

Prev Up  Next

Chapter 2. Background and Theory Home  2.2. Benefits of Seismic Inversion

http://opendtect.org/rel/doc/arkcls/sci/ch02s01.html (2 of 2) [21-10-2009 15:29:33]



2.2. Benefits of Seismic Inversion

2.2. Benefits of Seismic Inversion
Prev Chapter 2. Background and Theory  Next

2.2. Benefits of Seismic Inversion

Listed below are some the benefits of seismic inversion.

1.  More geoscientists understand the concept of impedance and 
geology than the seismic trace. Thus, working in the impedance 
domain is a great mechanism for integrating with the various 
disciplines in a multidisciplinary asset team.

2.  Removes the effects of the wavelet within the seismic bandwidth.
3.  Forces well ties to be made and understood.
4.  Reservoir properties are separated from the overburden.
5.  May provide quantitative predictions on the reservoir properties.
6.  Stratigraphic interpretation may be improved.
7.  Interpreting in the impedance domain is frequently easier than in 

the seismic domain.
8.  Possibility of extending beyond the seismic bandwidth.
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2.3. Inversion Limitations

Whilst there are significant benefits there are limitations. For quantitative 
inversion it is necessary to have good quality input as the quality of the 
output is governed by this. With good quality seismic data which matches 
the well data then it may be possible to get a quantitative output. 
However, one must remember that seismic data has limited frequency 
content. Therefore it will not be possible to produce a meaningful 
inversion if the layers are thin. Such high frequency events cannot be 
resolved within the seismic bandwidth. Furthermore, using seismic alone, 
it will not be possible to resolve the low-frequency trends and for absolute 
impedance it will be necessary to input a geological model. Whilst it may 
be possible with a good quality input to get a quantitative output, these 
methods are complex, requiring skilled specialists. Such methods are time 
consuming and can be a source of error.

Whilst using good quality input data is always desirable, inverting poorer 
quality data can give very usable results. Qualitative or semi-quantitative 
inversion may yield significant benefits on any data and it is much easier 
to achieve and is less error prone. Frequently taking this approach is 
sufficient and can be done by a non-specialist within a much shorter time 
scale.

Before embarking on an inversion project it is important to investigate any 
well log data that is available. It is recommended the frequency content 
required to image the target is investigated.

1.  Estimate the frequencies available within the seismic by wavelet 
estimation or spectral analysis.

2.  Take the well impedance data and bandpass it to the same 
frequencies as the seismic data. As a rule of thumb use 15dB down 
point as limits.

3.  If the target is still visible then using Seismic Coloured Inversion 
should be adequate.

4.  If not, then need to add frequencies by model assumption (Note: 
this can be very risky - you get what you add).

In most cases using SCI will be sufficient. Using more sophisticated 

http://opendtect.org/rel/doc/arkcls/sci/ch02s03.html (1 of 2) [21-10-2009 15:29:34]



2.3. Inversion Limitations

techniques doesn't guarantee a superior result.
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2.4. Inversion techniques

There is a variety of techniques available to invert seismic data ranging from very simple to complicated. 
Let's consider two techniques: Parametric Inversion (sparse spike) and Coloured Inversion.

2.4.1. Parametric Inversion

Most inversion algorithms use parametric inversion where the earth is modelled by a series of parameters. 
Basically parametric inversion works like this:

1.  Start with an initial estimate of all the model parameters.
2.  Define a function that characterises where the current model deviates from a desired model.
3.  Update the model so as to reduce the deviation.
4.  Iterate 2 and 3 until an acceptable error level is reached.

The model parameters are automatically updated to reduce the error term. The error term itself is a weighted 
sum of a series of different terms. For example:

1.  Seismic misfit term.
2.  Reflection coefficient threshold term.
3.  Deviation from the starting model term.
4.  Trace by trace variation term.

These terms are limited on the expected AI values within specified layers. The model parameterisation 
together with the constraints and some of the above terms may extend the inversion beyond the bandwidth of 
the seismic. The most important of the above is the seismic misfit term. In order to generate the seismic 
misfit term, this form of inversion requires the user to supply an explicit wavelet. This is generally performed 
prior to performing the inversion itself. The benefit of this is that it forces the user to tie and understand the 
log seismic fit. However, the downside is the wavelet is affected by calibration errors in the logs. Generation 
of wavelet is a difficult task and can be error prone.

2.4.2. Coloured Inversion

Coloured Inversion takes a different approach that is more familiar to seismic processing. In simple terms 
we analyse various seismic and well log spectra to define an operator that shapes the average seismic 
trace spectra to that of a fitted smooth curve which is representative of the average AI log spectrum. This 
defines the amplitude spectrum of the required operator. Theory tells us that a 90 degree phase rotation is 
also required. This is incorporated into the operator. The assumption is that the input seismic data is zero 
phase. The Coloured Inversion operator is converted to the time domain and simply applied to the seismic 
volume using a convolution algorithm.

2.4.3. Synthetic example

Let us compare a synthetic example. Using model data we can generate synthetic seismogram. In the figure 
below we see three relative AI displays which are broadly similar. On the left we see the relative AI directly 
from the input model data. This is the result (i.e. the answer). On the top right is the Coloured Inversion 
result generated from the synthetic seismogram. On the bottom right is the sparse spike inversion from the 
same synthetic seismogram.

Figure 2.2. Synthetic comparison
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Now if we compare the display above in greater detail we will observe an interesting result. Let's consider 
the figure below. The top two displays labelled SS (for Sparse Spike) and CI (for Coloured Inversion). On 
first observation the SS result looks better as it would appear to offer higher resolution. However, if we 
compare both the SS and CI with the answer AI (bottom right) then it is the CI result which more 
closely resembles the input model. Why should this be? Tracking down the problem found that the 
wavelet required by SS was estimated slightly incorrectly (difference between the purple and blue curves in 
the bottom far right plot.) The original wavelet estimate is deficient at high frequencies, for which the derived 
AI solution must compensate. When the sparse spike inversion is given the correct wavelet, it gives a similar 
result to CI. Thus, this example shows how easy it is to get sparse spike inversion wrong even when the answer 
is known. CI doesn't suffer from this problem as it is not necessary to determine the wavelet.

Figure 2.3. Synthetic comparison in greater detail

 
2.4.4. Real data examples

Below are some real data examples showing the benefits of seismic inversion and, in particular, Coloured Inversion.

2.4.4.1. Comparison between Coloured Inversion and Unconstrained Sparse Spike

Figure 2.4. Coloured Inversion and Unconstrained Sparse Spike example

 
The real data example within the figure shows great similarity between the Coloured Inversion and 
the unconstrained Sparse Spike result. The advantage of using Coloured Inversion is that the result can 
be obtained within an hour or two, whereas, Sparse Spike inversion can take several days to perform and 
uses specialised software that is not available to many interpreters. Furthermore, there is no guarantee that 
the result will be superior and, as we have shown, if the wavelet is not estimated correctly the result can 
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frequently be worse.

2.4.4.2. Coloured Inversion used to Improving interpretation

Figure 2.5. Improving Interpretation example

 
The 3D X-line example in the figure above shows a comparison of Full Offset Stack section (top) and 
Coloured Inversion section (bottom). It can be seen that interpreting the Coloured Inversion can make it easier 
to identify events. In particular the fault at L2020 is less likely to have been interpreted using the Full Offset 
Stack only. In contrast, on the Coloured Inversion section It would be very difficult to miss. This is a good 
example of how inversion products can help improve interpretation.

2.4.4.3. Well Planning

Figure 2.6. Horizontal Well example

 
The example in the figure above shows how inversion products using a blue-yellow colour bar can be used in 
well planning (bottom left). Here the yellow colour indicates pay sands whilst the blue indicates non-pay 
lithologies. Compare this with the conventional seismic display (top left). The display below shows how a 
horizontal well can be planned on the basis of seismic inversion. The correspondence between predicted 
reservoir and actual reservoir is high.
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2.5. Seismic Coloured Inversion (SCI)

With the advent of multi-version interpretation of AVO and 4D many more 
3D volumes need interpreting. Traditional band-limited, fast-track 
inversion techniques (e.g. trace integration, recursive inversion and phase 
rotation) are prone to error because no account is taken of the seismic 
wavelet or calibration to the Earth. Sophisticated techniques, such as 
sparse spike do take account of the seismic wavelet, but require specialist 
skills and are time consuming. Even using sophisticated techniques the 
resultant seismic inversion can still give an erroneous result. What is 
needed is a technique which is fast, easy to use and is calibrated against 
well log AI data

Inversion of seismic data to Acoustic Impedance (AI) is usually seen as a 
specialist activity. In spite of publicised benefits, inverted data are only 
used in a minority of cases. To help overcome this obstacle, this algorithm 
which is quick and easy to use, can increase the use of inversion 
technology. SCI performs significantly better than traditional fast-track 
methods such as recursive inversion, and benchmarks well against 
unconstrained sparse-spike inversion. With the inclusion of de-trend and 
normalisation functionality within SCI, geophysical meaning can now be 
assigned to the observed amplitude changes in the derived impedance 
volumes. This can be very powerful, particularly with 4D projects. Once 
the SCI operator has been derived, it can be simply applied using the 3D 
processing tool included within the SCI software. In this way, inversion can 
be achieved within hours since the volume data do not have to be 
exported to another package. SCI takes into account the seismic wavelet 
and is consistent with log data. With this technique, it is now possible to 
routinely invert any dataset within hours and establish a base case against 
which more sophisticated techniques must be judged. SCI enables the 
rapid inversion of 2D/3D data. A single convolution inversion operator is 
derived that optimally inverts the data and honours available well data in a 
global sense. In this way, the process is intrinsically stable and broadly 
consistent with known AI behaviour in the area. Construction of the 
operator is a simple process and implementation can be readily performed 
within the processing module included in SCI. As an explicit wavelet is not 
required, other than testing for a residual constant phase rotation as the 
last step, this removes an inherently weak link that more sophisticated 
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processes rely on.

Generally, traditional inversion methods (e.g.sparse- spike) are time 
consuming, expensive,require specialists and are not performed routinely 
by the Interpretation Geophysicist, whereas SCI is rapid, easy to use, 
inexpensive, robust and does not require expert users. SCI and 
unconstrained sparse-spike appear to give broadly equivalent results. SCI 
seamlessly connects with third party seismic and well data repositories 
(including SeisWorks, OpenWorks, GeoFrame and OpendTect) using our 
client/server technology. This allows SCI analysis,operator design and 
processing to be performed without separately importing or exporting data.
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2.6. Seismic Spectral Blueing (SSB)

Observed behaviour of reflectivity data obtained from wells shows that, in 
a global sense, the higher the frequencies the higher the amplitude. We 
refer to this as the spectrum being blued. During the processing of seismic 
data the amplitudes are often whitened. Spectral shaping of seismic data 
using SSB can enhance resolution without boosting noise to an 
unacceptable level.

SSB sections are usually easier to interpret and reveal more information 
about the subsurface. Small scale faulting, not seen on the original 
section, is often observed. Such additional information can be useful 
during well planning. SSB is rapid, easy to use, inexpensive, robust and 
does not require expert users. SSB seamlessly connects with third party 
seismic and well data repositories (including SeisWorks, OpenWorks, 
GeoFrame and OpendTect) using our client/server technology. This allows 
SSB analysis, operator design and processing to be performed without 
separately importing or exporting data.
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Table of Contents
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This tutorial is designed to get you up and running with the SciQt software 
quickly. This tutorial is split into the following sub-sections.

1.  Launching the SciQt
2.  Selecting data
3.  Designing and saving the Coloured Inversion operator
4.  Applying the Coloured Inversion operator
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3.1. Launching the SciQt OpendTect plug-in

This sub-section describes how to launch SciQt from within OpendTect.

1.  From within OpendTect main window click menu Processing->Attribute... or click 

the  icon to pop up the Attribute Set window (see figure below).
2.  Select Coloured Inversion in the Attribute type list to show the parameters 

required for this attribute.
3.  Click Select... to the right of the Input Data label to pop-up a dialog to allow the 

input volume to be selected.
4.  It is recommended that you don't supply a name for the SciQt wavelet at this 

time.
5.  Now click the Analyse and Create... to launch the SciQt plug-in.

Figure 3.1. Attribute Set used to launch SciQt
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Once launched the SciQt main window will be displayed. This window is the main 
interface to the application. The main window GUI consists of (from top to bottom): a 
menu area, an icon area, a chart area and a status area (see figure below). The chart 
area, which occupies the large scrollable central area of the main window, is used to 
display various charts of spectra and time data to provide feedback to the Interpretation 
Geoscientist in his/her quest to design a SciQt operator.

Figure 3.2. Seismic Coloured Inversion main window

Seismic Coloured Inversion 
main window
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3.2. Selecting Data

SciQt integrates with various third party data repositories. This should be 
transparent to you and is dependent on how the software was launched. 
To use the Coloured Inversion application to design an operator, it is first 
necessary to analyse the seismic and well data spectra. This is achieved by 
loading some seismic trace data and well log impedance data in time. Pop 
up the "Select Input Data" dialog by either clicking the Input Seismic and 

Well data... menu item under the Tools menu bar or by clicking the  
icon.

The table below shows both tabs of the Select Input Data dialog with an 
example of data selected for Coloured Inversion operator design. Seismic 
Coloured Inversion is data driven which means that the complete analysis 
and design of the operator (or as far as possible) are performed as soon 
as the data is selected/loaded or updated.

3.2.1. Input Seismic

With the "Select Input Data Dialog" displayed, click the "Input Seismic" tab 
(default) to select the input seismic data to be used. The SciQt will 
connect with various data repositories depending on the environment in 
which the Coloured Inversion software is being run. It attempts to do this 
in such a manner that the Geoscientist need know only minimal 
information to be able to connect seamlessly with the seismic database. 
However, as data repositories from third party vendors use different 
techniques to store data, there will inevitably be some differences with the 
specific seismic selection mechanism.

Figure 3.3. Select Input Data Dialog (Input Seismic Tab)
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The figure above shows the Select Input Data dialog for seismic selection. 
Whilst this dialog might look busy you should find it easy to provide the 
required parameters if you follow the steps below.

1.  Selected Seismic

The Select Seismic... push button allows you to pop-up a seismic 
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volume selector allowing you to select a seismic volume.
2.  3D Survey Area

Trace data for the spectral analysis can be selected from either the 
full 3D survey area or from a sub-area using the In-line/X-line Start 
and End input fields. By default the full area is selected.

3.  Load Seismic

Clicking the Load Seismic button causes the random set of traces 
over the 3D Survey Area to be loaded (Input tab) for spectral 
analysis. At the same time an alternative set of traces are loaded 
(QC tab) which are used to QC the derived operator.

4.  Set Time Range

The aim is to design a Coloured Inversion operator for the zone of 
interest (target). It is therefore desirable to time gate the selected 
traces prior to generating trace spectra. Ideally, you should use a 
well defined interpreted horizon in the target zone to guide the 
seismic trace time gate. In this manner, the various gated traces 
should have sample values over a similar geology.

Click Select Horizon... to pop up a horizon select dialog, then select 
horizon and then click Close button to return.

Click Horizon in the Range radio button and specify the Relative 
Start and Relative End values. A negative number is a relative time 
above the horizon (i.e. shallower) and a positive number is a 
relative time below the horizon (i.e. deeper). The aim is to select a 
time gate trace which has a gate length within the range 500 - 1000 
msec. The user supplied values here are accepted and the chart 
area updates when you do any of the following: press Return key, 
press Enter key, press Tab key, or mouse click on a different widget.

Note: If no horizon data is available and if seismic volume is 
relatively flat, then using an absolute sub range would be adequate. 
If it is not flat or the geology changes considerably over the 3D 
survey area then the selection of a smaller 3D Survey Area might be 
desirable.

3.2.2. Input Well Log

With the "Select Input Data" dialog displayed click the "Input Well Log" tab 
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to select the well log data to use. The SciQt software supports reading 
acoustic impedance in time, from ASCII files or by connection to a well log 
data repository. Here we shall assume you will normally wish to obtain 
data from OpendTect well log data repository and we will describe this 
route. If you wish to load from ASCII files then please refer to the full User 
Manual.

Figure 3.4. Select Input Data dialog (Input Well Log tab)

 
The list below show the steps to generate well log spectra:

1.  Load Wells
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Clicking the Load Wells push button will auto select acoustic 
impedance log curves in the OpendTect data repository. It is 
assumed that acoustic impedance log will have the characters 
"AI" (upper or lower case) or "IMP" (upper or lower case) 
somewhere within the log curve name. If, for a given well, there are 
no such acoustic impedance log curves or the log curve doesn't 
meet the assumed naming convention, then the user can still select 
or generate AI log curves manually. This is achieved by right 
clicking on the well name after first attempting to load the wells 
automatically. Note the Load Wells push button will change to a 
Reload Wells push button after the initial automatic selection.

Right clicking will pop-up a menu with Select AI Log... and Generate 
AI Log... menu items. Selecting the first item will pop-up the "Select 
Database Logs" dialog which lists the available logs allowing you to 
choose an AI log curve however it is named. Selecting the second 
item will pop-up the "Generate AI Log" dialog which displays two 
lists. The left hand list allows you to select a sonic log and the right 
hand list allows you to optionally select a density log. If no density 
is available, then you can select User for Density Source radio 
button and for supplying a User Density Value. Here the AI log will 
be generated from the supplied sonic and density. In OpendTect log 
curves are stored in depth. SciQt requires the AI log curves to be in 
time.

This transformation and resampling is done automatically, using the 
Depth/Time model allocated for each well. This data in the time 
domain can be displayed on one or more Main Window charts. By 
default, the AI data (in time) is displayed on the "Log Input (time 
domain)" and "Log Input Detrend (time domain)" charts. As each AI 
log curve is loaded its amplitude spectra are also immediately 
calculated and displayed by default on the "Individual Wells" chart.

The central area of the "Select Input Data" dialog (Input Well Log 
tab) shows the available AI log curves for each well. You can 
deselect wells and/or log curves by clicking on the appropriate 
checkbox.

2.  Set Time Range

Again our aim is to design a Coloured Inversion operator for the 
zone of interest (target). It is therefore desirable to time gate the 
selected traces prior to generating well log spectra. Ideally you 
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should use a well defined interpreted horizon in the target zone to 
guide the well log trace time gate. In this manner the various gated 
log traces should have sample values over a similar geology.

Click Select Horizon... to pop up a horizon select dialog, select the 
horizon you require and then click Close button to return.

Click Horizon in the Range radio button and specify the Relative 
Start and Relative End values. A negative number is a relative time 
above the horizon (i.e. shallower) and a positive number is a 
relative time below the horizon (i.e. deeper). The aim is to select a 
time gate which has a gate length within the range 500 - 1000 
msec. The user supplied values here are accepted, and the chart 
area updates when you do any of the following: press Return key, 
press Enter key, press Tab key or mouse click on a different widget.

With the seismic and well data loaded, the SciQt application will complete 
all the various steps to generate a Coloured Inversion operator. However, 
with this data driven approach the initial derived Coloured Inversion 
operator may not be ideal. As such, it may be necessary for you to perturb 
some of the design parameters before saving the operator. Apart from 
controlling desired data and data ranges, all other design parameters are 
accessible via "Design Operator Dialog" (see section below) and the 
"Advanced Controls" dialog.
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3.3. Designing and Saving the Coloured Inversion Operator

Various parameters exist which allow the Geoscientist to perturb how the operator is generated. In SciQt 
these changes occur in real time so you will be able to see immediately the effect of the change you have 
made. Pop up the "Design Controls Dialog" by either clicking the Design Controls... menu item under the 

Tools menu bar or by clicking the  icon.

Figure 3.5. Design Controls dialog

 
The figure above shows the Design Controls dialog. This dialog allows you to tweak various parameters in 
the generation of the Coloured Inversion operator. The steps below give you a brief overview of the 
parameters found on the Design Controls dialog.

1.  Smoothing Seismic Mean

This controls the amount of smoothing that will be applied to the seismic mean spectra. The operator length 
is specified in Hertz.

2.  Fit Well Log Curves

These spinboxes control the lower and upper boundaries for the principal curve fit. Outside this range the curve 
is, by default, extrapolated on the lower end and forced to be horizontal on the upper end (with smoothing 

applied in the vicinity of the boundary). Other curve fitting controls are available via the  icon or 
Tool->Advanced Controls... menu item.

3.  Design Operator

By default, the low and high cut points are automatically determined. You can override these settings manually 
by unchecking the checkbox to the left of the Low Cut and High Cut spinboxes. This will sensitise the Low Cut 
and High Cut spinboxes allowing you to set the lower and upper cuts of the derived operator. You can also 
specify the slope of the operator on the low and high sides by unchecking the checkbox to the middle Auto 
Calc. checkbox and specify the frequency of the -60 dB down points on the low and high sides.

By default, operator length is also automatically determined. Here the operator length is truncated to the 
nearest zero crossing to give a percentage energy captured during the generation of the time domain 
operator above 99.9%. You can override this default by unchecking the checkbox to the left of the Num. Zero 
X-ings spinbox. This will sensitise the Num. Zero X-ings spinbox allowing you to manually adjust the length of 
the operator in multiples of number of zero crossings.

A facility is provided to automatically QC the derived operator. This is achieved by applying the operator to 
the alternative set of random traces from the same seismic data volume and charting the derived residual 
operator in the "Residual Operator (QC)" chart. We are looking for the residual operator to be centred around 
zero and essentially flat. By perturbing the Low Cut and High Cut spinbox controls within the "Design 
Operator" group, you can usually maximise the bandwidth in such a manner without significant residual 
correction either end (see figure below for example of a corrected chart).

Figure 3.6. Seismic Coloured Inversion main window after analysis and design
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The figure above shows a typical SciQt main window with the default charts re-arranged in five columns. Note: 
the default templates arrangement of charts is two columns. The following gives a brief description of each of 
the charts displayed using the supplied default template (moving left to right and top to bottom)

1.  Raw Seismic

This chart displays the spectra for each of the random set of seismic traces loaded in the main set used in 
the analysis and design of the Coloured Inversion operator.

2.  Seismic Mean

This chart displays the mean spectrum (red) of all the raw spectra. It also displays the smoothed mean 
spectrum (black). The smooth mean spectrum (see description in 7. Design Operator) is used to derive 
the Coloured Inversion operator.

3.  Log Input (time domain)

This chart displays the well impedance logs in time domain. In this case there is only one impedance log 
but typically there are more. Also displayed on this chart is the trend line (black).

4.  Log Input Detrend (time domain)

This chart displays the well impedance logs with the trend removed. Note that the ramp has also been applied 
at the end of the impedance log. Detrending and ramping are designed to remove the possibility of artifacts 
being introduced in the Fast Fourier Transform process.

5.  Individual Wells

This chart displays the spectra of well impedance logs. On this chart the x axis is displayed using a 
logarithmic scale.

6.  Global

This chart displays the mean spectrum (global) of all the well log impedance spectra. On this chart the x axis 
is displayed using a logarithmic scale. Also displayed is a curve fit spectrum (black). The band limited version 
of this curve fit spectrum (see 7. Design Operator) is used to derive the Coloured Inversion operator.

7.  Design Operator

This chart displays the band limited well log impedance curve fit (green), the smooth seismic mean spectrum 
(red) and the derived Coloured Inversion operator spectrum (blue). The Coloured Inversion operator shapes 
the smooth seismic mean spectrum to the band limited well log impedance curve fit at every frequency.

8.  Operator (time domain)

This chart displays the Coloured Inversion Operator in the time domain with a -90 degree phase shift applied 
and appropriately truncated. By default, truncation ensures that at least 99.9% energy is captured.

9.  Residual Operator (QC)

This chart displays the band limited well log impedance curve fit (green). This is the same as in 7. Design 
Operator above. Also displayed is the smooth mean spectrum (red) of the Colour Inverted alternative set (QC) 
of random traces. As you can see, this spectrum overlays the band well log impedance curve fit within the 
band width. The residual operator (blue) should have essentially zero amplitude within the band width

10.  Convolved Output Mean (QC)

This chart displays the mean spectrum (red) of the Coloured Inverted alternative set (QC) of random traces. 
Also displayed is the band limited well log impedance curve fit (black)
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3.4. Application of SciQt operator

This section describes how the derived Coloured Inversion operator can be 
applied to your data using the OpendTect plug-in. Application of the 
Coloured Inversion operator can be done in various ways. Please refer to 
OpendTect documentation for full details. For the purpose of this 
document, we will only describe a couple of the mechanisms which you 
could use. Now, depending on whether you wish to run a test or whether 
you want to process a complete volume or sub-volume read the respective 
sub-section below. Running a test first is a good idea as you will have the 
opportunity to quickly view the result of applying your ColourInversion 
operator to a sample inline or xline before applying the operator to the 
entire 3D volume.

3.4.1. Testing the Coloured Inversion operator

This is best achieved via the OpendTect "Attribute Set" dialog. If you 
haven't closed the "Attribute Set" dialog used to launch the SciQt plugin, 
then it should still be somewhere on your desktop (possibly hidden behind 
other windows). At this stage you will need to select the operator to use. 
You should see that the desired Coloured Inversion operator has been 
automatically selected in the Input Wavelet field. If not automatically 
selected or you require a different Coloured Inversion operator then click 
the Select... push button to the right of Input Wavelet label which will pop 
up a dialog with a list of available wavelets. This list will include both the 
Coloured Inversion operator (suffix _ci) and the Band Pass operator (suffix 
_bp). Both these wavelets were saved during the SciQt analysis and 
design. From the list, select the Coloured Inversion wavelet (suffix _ci). 
The final step before running your test will be to give your attribute a 
name via the input field to the right of Attribute name label and click the 
Add as new button. Now, assuming that an In-line or X-line graphical 
element is displayed within OpendTect and that one of these items is 
selected as active, then it is very easy to see the effect of the derived 

Coloured Inversion operator by clicking the  icon within the OpendTect 
"Attribute Set" dialog. This will immediately apply the Coloured Inversion 
operator to the selected "Input Data" in the Attribute Set for the In-line or 
X-line graphic element currently displayed. Display will then be updated 

http://opendtect.org/rel/doc/arkcls/sci/ch03s04.html (1 of 3) [21-10-2009 15:29:57]



3.4. Application of SciQt operator

and, if it is visible in one of the scenes, you will immediately see the result. 
This is a very useful QC tool which will allow you to view the results of 
applying the derived Coloured Inversion operator to your data before 
committing to processing multiple 3D inlines (sub-volume) or the entire 3D 
seismic volume.

3.4.2. Applying the Coloured Inversion operator

Application of the Coloured Inversion operator is achieved via the 
OpendTect attribute processing facility (see OpendTect documentation 
chapter 5 for details of how to do this). In brief, this can be achieved by 
either clicking Processing->Create Seismic output... menu item or clicking 

the  icon within the OpendTect main window. This will pop up the 
"Process" dialog.

Figure 3.7. OpendTect Coloured Inversion Processing

 
The list below describes how you specify the various parameters to the 
Process controller to Create a Coloured Inversion output.
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1.  Quantity to Output

Clicking the Select... push button to the right of the "Quantity to 
output" label allows you to select the named attribute to be used in 
the processing. The named attribute should be the attribute you 
added as new in section "Testing the Coloured Inversion operator". 
The named attribute knows: the type of attribute/process (in this 
case Coloured Inversion), the input data and the input wavelet to be 
applied.

2.  Volume subselection

Clicking the Select... push button to the right of the "Volume 
subselection" label allows you to specify whether you wish to 
process the entire input volume or a sub-volume.

3.  Output Cube

Clicking the Select... push button to the right of the "Output Cube" 
label allows you to select an existing cube to be overwritten or to 
specify a new cube to be created.

4.  Submit to

Click the Single machine radio button to submit this processing job 
to a single machine. Details of using Single or Multiple machines can 
be found in the OpendTect documentation.

5.  Store processing specification as

Recommend that you accept the default. All other parameters on 
this dialog can be ignored.

6.  Proceed

Click the Proceed push button to start the batch Coloured Inversion 
processing within OpendTect
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4.1. Interfacing with the SciQt Application

This section describes how you interface with the SciQt Main Window and the SciQt Main 
Window ancillary tools. The primary tools allowing you to load data, analyse, design and 
apply the Coloured Inversion operator are described in greater detail in later sections.

4.1.1. SciQt Main Window

The Coloured Inversion main window GUI consists of, from top to bottom, a menubar area, 
a toolbar area, a chart area and a status area (see figure below). The chart area which 
occupies the large central area of the main window is used to display various charts of 
spectra and time data providing instant feedback to the Interpretation Geoscientist in his/
her quest to design a Coloured Inversion operator. The four sub-sections which follow will 
provide you with a description of each of these areas. We will pay particular attention to 
the central chart area.

Figure 4.1. SciQt main window
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4.1.1.1. Menubar Area

This sub-section describes the actions performed by the various menu items

4.1.1.1.1. File

New Creates a new SciQt session using the default template (shortcut 
Ctrl+N).

New From Template...

Creates a new SciQt session a using a user saved template. By 
default, the software will look for templates stored in a special 
directory, created for this purpose, within the SciQt installation 
tree. However, if you have set the environment variable 
CLS_SCI_TEMPLATE_DIR to point to another directory, then it will 
look in this location for templates.

Open...

Opens a previously saved SciQt session (shortcut Ctrl+O). This 
facility allows you to restore the SciQt parameters together with 
the data from a previously saved session. Restoring a previously 
saved session can take a few moments while database access is 
established. Note, if the stored data within the database has been 
modified since the session save time, then it is possible that a 
Coloured Inversion operator, which is different to that available at 
the session save time, might be generated following a session 
restore.

Save

Saves a SciQt session. This allows the SciQt parameters, together 
with information about the data used, to be saved. In this way, 
data can be easily reloaded and the SciQt Coloured Inversion 
operator generated at some future date. If this is the first time 
that this is saved then the user will be presented with a file 
selector dialog for this purpose (shortcut Ctrl+S).

Save As...
Saves the current SciQt session under a different name. A file 
selector dialog will pop-up for this purpose. See "Save" above for 
more details.
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Save As Template...

Saves the current SciQt session as a new template. By default, 
new templates will be saved in the site wide templates directory 
in the software installation tree $CLS_APP/Sci/templates/Sci. 
However, it is likely that you will not have write access to this 
directory. You can get around this problem by setting the 
environment variable CLS_SCI_TEMPLATE_DIR to a writable 
directory before starting the Coloured Inversion application. This 
will then give you write access to an alternative templates 
directory.

Save Operator...

Saves the SciQt Coloured Inversion operator set to the database. 
This menu item will pop up a Save Operator dialog. The dialog 
will list all the operator sets currently stored in the OpendTect 
database. A filter facility is provided to help you find an existing 
operator set should your list be very long. Through this dialog you 
can either select an existing operator set or specify a new 
database name to save the current Coloured Inversion operator 
set. A set will consist of two wavelets with the database name 
being suffixed with _ci for the Coloured Inversion operator and 
_bp for the Band Pass operator.

Print >

Print... Print both the report and the charts to a specified printer. 
Alternatively, you can print to file. However, if this option is 
selected then there is a known bug which will cause the charts 
output to overwrite the report output. If you need to output both 
the report and the chart to a file, then use Print Report... and 
Print Charts... separately.

Print Report... Prints the report to a specified printer. 
Alternatively, you can print the report to a file.

Print Charts... Print the charts to a specified printer. Alternatively, 
you can print the charts to a file.

Screenshot >

All Charts... Save all charts in the central area to an image file. 
The following image formats are supported: PNG (default), JPEG, 
and BMP.

Visible Charts... Save charts that are currently visible in the 
central area.

Import/Export >

Import Chart Configuration... Pops up a file selector dialog which 
will allow you to select a previously saved session. The chart 
configuration of that session file is applied to your current 
session. Note the data and parameters stored in the session files 
are ignored. This provides you with a very powerful facility which 
allows you to view your current data using a variety of different 
chart configurations.

Export Operator... Allows you to export the operator to an ASCII 
file.

Export Data Item... Exports one or more of any of the currently 
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displayed data items to an ASCII file.

Parameter Report... Pops up a dialog which displays various Coloured Inversion 
parameters nicely formatted.

Exit Exits the SciQt application.

4.1.1.1.2. View

Chart Controller... Pops up the "Chart Controller Dialog" which will allow you to modify 
various chart parameters within the central area of the main window.

Refresh Charts Redraws all the charts within the central area of the main window.

Zoom In
Provides a global zoom-in facility which makes the central chart area 
grow by a fixed amount each time this menu item is clicked. There is 
an upper maximum.

Zoom out
Provides a global zoom-out facility which makes the central chart area 
shrink by a fixed amount each time this menu item is clicked. There is 
a lower minimum.

4.1.1.1.3. Tools

Input Seismic and Well data...
Pops up the "Select Input Data" dialog which allows you 
to select the seismic and well log data to use in the 
analysis and operator design.

Design Operator...
Pops up the "Design Operator" dialog which allows you to 
control standard parameters in the design of the SciQt 
operator.

Advanced Controls...
Pops up the "Advance Controls" dialog which allows you 
to override many of the standard parameters in the 
design of the SciQt operator.

4.1.1.1.4. Help

Quick Start... Pops up an HTML browser displaying the Quick 
Start document.

Help Contents... Pops up an HTML browser displaying Contents 
page for software user guide.

Background and Theory... Pops up an HTML browser displaying Background 
and Theory to the software.

Generate Installation Status Report...

Pops up a file selector dialog allowing you to 
specify a file which will be used to save information 
about this installation. The file will be saved as a 
gzipped compressed text file. ARK CLS support 
staff may ask you to generate a report to help 
them resolve issues with the software. If 
requested, please email this file to support@arkcls.
com
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Website... Pops up an HTML browser displaying the home 
page of ARK CLS Limited website.

About... Pops up the About SciQt window.

4.1.1.2. Toolbar Area

This sub-section describes the actions performed by the various toolbars and their icons. 
The toolbars can be positioned in various locations within the main window top (default 
beneath the menu bar), left, right and bottom (above status area). Additionally, the 
toolbars can be moved off the main window altogether and anchored on the desktop. To 
move the toolbar to a new location grab the handle at one end of the toolbar by pressing 
and holding mouse button 1 and dragging to the new location.

4.1.1.2.1. File Toolbar

Creates a new SciQt session.

Opens a previously saved SciQt session. This facility allows you to restore the SciQt 
parameters together with the data from a previously saved session. Restoring a 
previously saved session can take a few moments while database access is 
established. Note, if the stored data within the database has been modified since the 
session save time, then it is possible that a Coloured Inversion operator, which is 
different to that available at the session save time, might be generated following a 
session restore.

Saves an SciQt session. This allows the SciQt parameters, together with information 
about the data used, to be saved. In this way, data can be easily reloaded and the 
SciQt Coloured Inversion operator generated at some future date. If this is the first 
time that this is saved then the user will be presented with a file selector dialog for 
this purpose.

Saves the SciQt Coloured Inversion operator set to the database. This menu item 
will pop up a Save Operator dialog. The dialog will list all the operator sets currently 
stored in the OpendTect database. A filter facility is provided to help you find an 
existing operator set should your list be very long. Through this dialog you can 
either select an existing operator set or specify a new database name to save the 
current Coloured Inversion operator set. A set will consist of two wavelets with the 
database name being suffixed with _ci for the Coloured Inversion operator and _bp 
for the Band Pass operator.

Print both the report and the charts to a specified printer. Alternatively, you can 
print to file. However, if this option is selected then there is a known bug which will 
cause the charts to overwrite the report. If you need to output both the report and 
the chart to a file then use menu File->Print->Print Report...and menu File->Print-
>Print Charts... separately.

Displays parameter report. This icon pops up the "Parameter Report" dialog.

4.1.1.2.2. Tools Toolbar
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Pops up the "Select Input Data Dialog" which allows you to select the seismic and 
well log data to use in the analysis and operator design.

Pops up the "Design Operator" dialog which allows you to control standard 
parameters in the design of the SciQt operator.

Pops up the "Advanced Controls" dialog which allows you to override many of the 
standard parameters in the design of the SciQt operator.

4.1.1.2.3. View Toolbar

Pops up the "Chart Controller" which allows you to modify various chart parameters 
displayed in the central area of the main window.

Redraws all the charts on the central area of the main window.

Provides a global zoom-in facility which makes the central chart area grow by a fixed 
amount each time this menu item is clicked. There is an upper maximum.

Provides a global zoom-out facility which makes the central chart area shrink by a 
fixed amount each time this menu item is clicked. There is a lower minimum.

This icon pops up the online help system.

4.1.1.3. Chart Area

This is the main functional area of the SciQt application. It is used to display various charts. 
These charts are used to display various spectra data and time domain data. The chart 
area provides graphical feedback of the various stages in the generation of the Coloured 
Inversion operator for the given data and program parameters supplied by you. The chart 
area is also dynamic, allowing you to interface directly with the charts within this area. You 
can interactively update these charts in real time by modifying the various parameters in 
the "Select Input Data" dialog, "Design Operator" dialog and the "Advanced Controls" 
dialog. We call this data driven, as the effect of you modifying a parameter within the 
above dialogs is an immediate update to the graphical charts. Whereas, in earlier versions 
of the software it was necessary to click a push button at every stage to see an update.

The chart area is highly configurable allowing you to tailor this area with charts and data 
which meet your particular project needs. Once you have configured this area it can then 
be saved as a session, which will allow you to easily return to the chart/data configuration 
at some future date. You can also save the chart area configuration with types of data 
object to be displayed in a given chart as a template. This will allow you or your colleagues 
to use such templates on other projects. Another benefit of saving as a template and/or 
session is that you can apply the chart configuration from a saved template or session to 
your current session.

The following figures show an example of an SciQt run using the supplied default template:

Figure 4.2. SciQt main window - default configuration (showing the top four 
charts)

http://opendtect.org/rel/doc/arkcls/sci/ch04s01.html (6 of 13) [21-10-2009 15:30:04]



4.1. Interfacing with the SciQt Application

 
Chart 1 Raw Seismic - This chart displays the raw gated seismic trace spectra. By 
default, a random set of 40 seismic traces within the 3D Survey Area is loaded when the 
Load Seismic push button is clicked. This push button is located within the "Input Seismic" 
tab on the "Select Input Data" dialog. Changing the time gate and/or range mode will 
update this chart. It is recommended that, if an interpreted horizon (with few undefines) is 
available within the target area then Range mode (radio button) be set to "Horizon"

Chart 2 Seismic Mean - This chart displays the mean seismic spectrum. The mean 
seismic spectrum (red) is derived from the raw gated seismic trace spectra in chart 1. 
Clicking the Load Seismic button within the "Input Seismic" tab on the "Select Input Data 
Dialog" will update the data on this chart. Also displayed on this chart is a smooth mean 
seismic spectrum (black). The amount of smoothing can be controlled by you interacting 
with the Smooth Seismic Mean control on the "Design Operator Dialog".

Chart 3 Log Input (time domain) - This chart displays the selected gated AI log data in 
time. In this example only one AI log has been selected. Selecting or de-selecting AI log 
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data in the "Input Well Log" tab on the "Select Input Data Dialog" will update the data on 
this chart. Also displayed on this chart is the linear trend line (black). Controls on the 
"Advanced Controls" dialog can also have an immediate effect on this chart.

Chart 4 Log Input Detrend (time domain) - This chart displays the selected gated AI 
log data in time with the linear trend line removed. In this case, end ramping has also 
been applied so the log ends intercept the zero axis. Selecting or de-selecting AI log data 
in the "Input Well Log" tab on the "Select Input Data Dialog" will update the data on this 
chart. Controls on the "Advanced Controls" dialog can also have an immediate effect on 
this chart.

Figure 4.3. SciQt main window - default configuration (showing the middle four 
charts)

 
Chart 5 Individual Wells - This chart displays the individual AI log spectra. As there is 
only one AI log selected in this example, there is only one log spectrum to be displayed. 
Selecting AI log data in the "Input Well Log" tab on the "Select Input Data" dialog will 
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update the data on this chart.

Chart 6 Global - This chart displays the mean (or global) of the individual AI log spectra. 
In this example, there is only one individual AI log spectrum so the global spectrum is the 
same as the single individual AI log spectrum. Also displayed on this chart is the curve fit 
spectrum (black). Various controls on the "Design Operator" dialog and in the "Advanced 
Controls" dialog can have an immediate effect on this chart.

Chart 7 Design Operator - This chart displays three curves: The curve coloured "red" is 
the smooth mean seismic spectrum. The "green" curve is the band-limited spectrum 
derived from the smooth composite curve fit to the average AI spectrum. Finally, the "blue" 
curve is the band-limited shaping operator. Note: the maximum frequency of the chart is 
determined by the maximum nyquist frequency of either the log data or the seismic data. 
Various controls on the "Design Operator Dialog" and in the "Advanced Controls" dialog 
can have an immediate effect on this chart.

Chart 8 Operator (time domain) - This chart displays the time converted Coloured 
Inversion operator. Various controls in the "Select Input Data" dialog, "Design Operator" 
dialog and "Advanced Controls" dialog can have an immediate effect on this chart.

Figure 4.4. SciQt main window - default configuration (showing the bottom two 
charts)

 
Chart 9 Residual Operator (QC) - This chart displays the following spectra and is used 
for QC purposes.

1.  Smooth mean Coloured Inversion data (red)
2.  Band limited curve fit to global AI spectrum (green)
3.  Residual operator (blue). This should tend to be flat and centred around zero.
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Various controls in the "Select Input Data" dialog, "Design Operator" dialog and "Advanced 
Controls" dialog can have an immediate effect on this chart.

Chart 10 Convolved Output Mean (QC) - This chart displays the mean Coloured 
Inversion data (red) and the smooth mean Coloured Inversion data (black). Various 
controls in the "Select Input Data Dialog", "Design Operator Dialog and "Advanced 
Controls" dialog can have an immediate effect on this chart.

4.1.1.4. Status Area

The status area at the bottom of the main window is used to display various messages and 
other information for you. For example, if you pass the mouse over a toolbar icon then a 
tip is displayed in this area indicating what the purpose of the icon is. The status area is 
also used to display information about a given chart as the mouse passes over the central 
area of the main window.

4.1.2. SciQt Main Window ancillary tools

There are various main window ancillary tools within the SciQt application which you might 
find helpful and deserve a mention. These are Save Operator, Export Operator, Export 
Data Item and Parameter Report.

4.1.2.1. Save Operator

The Save Operator tool allows you to save an operator to a database. Clicking the File-
>Save Operator... menu item will pop up the "Save Operator" dialog. If you haven't saved 
the operator during your session or if the operator has changed since you last saved it, 
then you will be prompted to save the operator before the SciQt program exits.

Figure 4.5. Save Operator dialog
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The figure above shows the "Save Operator" dialog. This allows you to select a previously 
saved Coloured Inversion operator or to specify a new Coloured Inversion operator. Either 
way when you click the Save push button the current time domain operator will be saved 
to the database by the name in the Select Operator input field here. If the operator already 
exists in the database you will be warned that you are about to overwrite the operator.

4.1.2.2. Import Chart Configuration

The Import Chart Configuration tool allows you to import from a saved session the chart 
configuration defined within that session. This is a powerful facility allowing you to rapidly 
change your display layout using your current data items. Clicking the File->Import/
Export...->Import Chart Configuration... menu item will pop up a file selector dialog. Here 
you can traverse the file system to import the chart configuration from a previously saved 
session file.

4.1.2.3. Export Operator

The Export Operator tool allows you to export an operator to an ASCII file. Clicking the File-
>Import/Export...->Export Operator... menu item will pop up a file selector dialog. Here 
you can traverse the file system to export the Coloured Inversion operator as an ASCII file.

4.1.2.4. Export Data Item

This is a powerful ancillary tool which allows you to export any of the loaded or generated 
data items (time or frequency domain curves) to an ASCII file. Clicking the File->Import/
Export...->Export Data Items... menu item will pop up the "Export Data Item" dialog.

Figure 4.6. Export Data Item dialog
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The figure above shows the "Export Data Item" dialog. This dialog contains a list view 
widget which allows you to export, to an ASCII file, either all the data items for every 
group, all the data items for a single group or a single data item from a group. This is 
achieved as follows:

All Data Items: Clicking the "All Data Items" on the "Export Data Item" dialog will select 
every data item currently available. Then, by clicking the Export push button you will be 
given a file selector dialog allowing you to save all these data items into a single ASCII file.

Group Item: Clicking one of the groups beneath the "All Data Items" will select that group. 
Then, by clicking the Export push button you will again be given a file selector dialog 
allowing you to save the group data into a single ASCII file.

Data item: Clicking a data item within a group will select that data item. Then, by clicking 
the Export push button you will once again be given a file selector dialog allowing you to 
save the data item to a single ASCII file.

You can optionally output a header. This is useful if you are outputting two or more data 
items.

4.1.2.5. Parameter Report
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This ancillary tool allows you to display and optionally save the Coloured Inversion 
parameters in a nicely formated manner. Clicking the File->Parameter Report... menu item 
will pop up the "Parameter Report" dialog.

Figure 4.7. Export Data Item dialog

 
The figure above shows the "Parameter Report" dialog. This dialog displays the key 
parameters in the SciQt analysis and design phase nicely formated. Click the Save As... 
push button will pop up a file selector dialog allowing you to save to an ASCII file the 
formated parameter report.

Prev Up  Next

Chapter 4. User Manual Home  4.2. User interaction with Chart 
Area
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4.2. User interaction with Chart Area
Prev Chapter 4. User Manual  Next

4.2. User interaction with Chart Area

SciQt provides various mechanism to allow you to interact with the main window chart area. These interactions 
can be:

1.  Global - The interaction effects the whole chart area (eg global zooming)
2.  Chart level - The interaction effects an individual chart (eg change title of chart)
3.  Data object level - The interaction effect an individual data curve on the chart (eg set up plot rule)

Some of these interactions can be achieved directly on the chart area whereas other interactions require you 
to first pop up a dialog.

4.2.1. Direct Interactions

Direct interactions with the chart area allow you to interact with the chart without popping up additional dialogs

4.2.1.1. Global Zooming

Global zooming allows you to zoom the chart area in or out with the mouse.

Figure 4.8. Global Chart Area Zooming

.....

 
The images in the figure above show how the central chart area can be zoomed in and zoomed out in a 
global sense.

Zooming in is achieved by either clicking on the menu item View->Zoom In or clicking the  icon. The LH 
image shows the result on the charts of zooming in.

Zooming out is achieved by either clicking on the menu item View->Zoom Out or clicking the  icon. The 
RH image shows the result on the charts of zooming out.

4.2.1.2. Identifying Data

Frequently on charts there can be several curves plotted. Therefore identifying a particular curve amongst 
the jumble may appear to be a daunting task. However, a facility has been provided which allows you to point at 
a Vertex and clicking with mouse button 1 (MB1) will display the name of the curve in the status bar.

Figure 4.9. Identifying Data from Charts
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The images in the figure above show how data on an individual chart can be identified.

To identify data on a given chart point to a vertex on one of the data curves and press MB1 (you need to be 
near to a vertex). If you are close to a vertex when you click MB1, the curve name and the coordinates of 
the vertex will be displayed. This is useful since it gives you a mechanism for identifying anomalous curves so 
that they can be removed. In the LH image there is a spike on the red curve around 43Hz. Clicking on the tip 
of the spike identifies it as TRACE_005. Now, in this case, you can go to the "Input Seismic" tab on the 
"Select Input Data Dialog" and deselect it. The RH image shows the result of deselecting TRACE_005.

4.2.1.3. Data Zooming

Data zooming is different from global zooming as data zooming is only performed on an individual chart. 
Like global zooming it is quick and easy. Charts zoomed in this way stay zoomed until you revert them to 
an unzoomed state. You can zoom in and out on individual charts by pressing and holding the Control key 
then rotate the mouse wheel either towards you (zoom out) or away from you (zoom in). The zooming will 
be centred around the position of the mouse. Alternative methods for individual chart zooming are described below.

Figure 4.10. Data Zooming on Charts

.....

 
The images in the figure above show how data on an individual chart can be zoomed. Data zooming is the 
process of identifying a data area within a given chart and arranging the chart axis so that area fills the chart.

Data zooming is achieved by dragging a rectangular box (rubber band) over an area of the data on one of 
the charts that is to be zoomed. You invoke data zooming mode by pointing to the chart that is to be zoomed 
and pressing MB3. This pops up a menu. Select "Zoom Data (Shift MB1)" will put you in data zooming mode. 
Now pressing and holding MB1 and dragging will allow you to rubber band the area on the chart that is to be 
data zoomed. Letting go the MB1 will instantly data zoom the chart. After data zooming the MB1 will revert to 
its default mode "Identify Data". To unzoom the data press MB3 to pop up menu and select "Unzoom/
Recentre Data (Shift MB1). Another faster method of achieving the same result is to press and hold the Shift 
key whilst sweeping out a rectangle by pressing and holding MB1 and dragging over the area that is to be 
data zoomed. To unzoom simply hold down Shift key and press and release MB1 on the chart. If you have 
zoomed in multiple times, this action will unzoom in steps. Pressing MB2 on the chart will also unzoom in 

steps. Note the  icon which unzooms all and recentres the data in one go. This can also be achieved by 
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MB3 clicking and selecting the "Unzoom All/Recentre Data" pull down menu item.

The LH image shows the rubber band box identifying the area that is to be zoomed and the RH image shows 
the result of the data zoom.

4.2.1.4. Moving Data

Moving data is a mechanism which allows you to grab hold of the data on a chart and drag it to a new 
position. Essentially you are changing the axes on the chart coordinate system.

Figure 4.11. Moving Data on Charts

.....

 
The images in the figure above show how data on an individual chart can be moved.

Moving data is achieved by pointing to a position on a chart and moving that position to a new place. You 
invoke move data mode by pointing to the chart where you have data that is to be moved and click MB3. This 
pops up a menu. Select "Move Data (Ctrl MB1)" which will put you into move data mode. The next time you 
click and hold with MB1 on the chart the position to be moved will be identified. Whilst holding down MB1 move 
to the new position. Data will move interactively as you move to the new position. Letting go the MB1 will leave 
the data at the new position. After data moving the MB1 will revert to its default mode "Identify Data". To 
re-centre the data press MB3 which will pop up a menu then select "Unzoom/Recentre Data (Shift MB1). A 
faster method of achieving the same result is to press and hold Ctrl key then press and hold MB1 whilst 
dragging the data to the new position.

The LH image shows the old position of the data with the RH image showing the new position of the data.

4.2.1.5. Changing Axes

It is sometimes useful to see axes displayed differently. This is easily achieved via a pop up menu. Clicking MB3 
on a chart will cause the pop up menu to be displayed. The menu will show, amongst other options, a 
cascade menu for X Axis and Y Axis.

The cascade menu for the X Axis allows you to toggle between:

1.  Linear Scale or Logarithmic Scale
2.  Increasing Right or Increasing Left
3.  Axis at Bottom or Axis at Top

The cascade menu for the Y Axis allows you to toggle between:

1.  Linear Scale or Logarithmic Scale
2.  Increasing Up or Increasing Down

Figure 4.12. Changing Scales on Charts
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The images in the figure above show how an axis can easily be changed from a linear to a logarithmic scale.

By pressing and holding MB3 whilst hovering over the y axis or x axis or the data area of the chart, you can pop 
up a menu. In this case the user clicked over the y axis. Moving to the X Axis item on the pop up menu will 
cause the X Axis cascade menu to be displayed (LH image). Then, moving to the right over the Logarithmic 
Scale cascade menu item and releasing MB3 will cause the chart to be redrawn with a logarithmic X axis 
(RH image).

Other changes to the X and Y axes or chart data can be performed in a similar manner.

4.2.2. Chart Controller

The Chart Controller dialog allows you to change various properties of a chart. The Chart Controller will also 
allow you to create new charts, delete charts, edit charts, control layout (number of columns) and change 
the order of the charts within the chart area. A useful feature is that the current chart configuration can be 
saved to a XML file. Subsequently the XML file containing the chart configuration can be loaded to the 
current session. Chart configuration XML files do not save data or SciQt parameters so can be readily used in 
other projects or sessions. The Chart Controller dialog can be popped up by clicking menu item View-

>Chart Controller... or clicking the  icon. The figure below shows the Chart Controller. Changes made via 
the Chart Controller are immediately updated on the Chart Area of the Main Window.

Figure 4.13. Chart Controller dialog

 
The sub-sections below outline the various tasks that can be performed from within the Chart Controller.

4.2.2.1. Creating a New Chart

Creating a new empty chart is a very simple process. The table below shows an example of how this is achieved.
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Figure 4.14. Create a new Chart

.....

 
The two images in the figure above show how a new chart can be created.

With the Chart Controller dialog displayed, select an existing chart from the list of available charts. The 
selected chart will be highlighted (reverse video). Now, click the New push button (first image) which will cause 
a new empty chart to be inserted immediately below your currently selected chart (ie below the "Raw 
Seismic" chart in this case). Note in the chart area of the main window, charts are arranged in rows. So, in a 
two column arrangement the first chart will appear in row 1 column 1, the second chart appearing in row 1 
column 2 and third chart in row 2 column 1 and so on. In the Chart Title list the new chart named "New 
Chart", will become the currently selected chart and will be highlighted. The main window will also be updated 
to show the new empty chart.

To change the name of the new chart, simply click on "New Chart" and type the new name you require 
directly within the Chart Controller dialog. Here we have changed the name from "New Chart" to 
"Coloured Inversion". The Main Window will be updated as soon as you press "Return" or "Enter" or by 
clicking away from the just edited chart name in the list. You can change the name, at any time, of any of 
the charts in the list. With the new chart created it is normal to label the axis and to select the Data Items to 
be displayed in the chart. You can achieved this by clicking the Edit push button to pop up the "Display 
Options" dialog. In this case the user has labeled the X axis as "Freq (Hz)" (not visible) and Y axis as "Amp 
(dB)". The user has also selected the "Convolved Trace Spectra" group for the Data Item to be displayed in 
this chart.

The first images show Main Window before the new chart is added with the second image showing the 
Main Window after the new chart has been added and renamed.

4.2.2.2. Moving Charts

Moving charts is very simple. The table below shows an example of moving a chart within the chart area.

Figure 4.15. Moving Charts
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The images in the figure above show how a chart can be moved.

The first image shows the "Log Input (time domain)" chart selected. The SciQt Main Window shows the "Log 
Input (time domain)" chart in the bottom right corner of the display. Clicking the Move Up push button 
twice causes the chart to move up two positions in the Chart Controller dialog list. The Main Window is 
immediately updated with each click. The second image shows the "Log Input (time domain)" chart in its 
new position top right corner of the display.

The Move Down push button moves the chart in the opposite direction.

4.2.2.3. Deleting Charts

Like the other tasks described above, deleting charts is easy.

Figure 4.16. Deleting Charts

.....

 
The images in the figure above show how a chart can be deleted.

Just select the chart from the list and click the Delete push button. The chart is deleted immediately without 
any warning, so you are advised to be careful when using this option. The SciQt Main Window will 
update immediately to show the chart area with the deleted chart removed.

The LH image shows the "Log Input (time domain)" chart before clicking the Delete push button with the 
RH image showing the chart area with the "Log Input (time domain)" chart removed. Note, the charts below 
the deleted chart move up one position.
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4.2.2.4. Saving and Loading Chart Configurations

Saving and loading the chart configuration is a powerful facility which allows you to view your session in 
many different ways. Chart configurations are saved in XML files. Only information about the charts are saved 
in such files. This facility also allows you to use chart configurations saved from previous sessions in other 
projects. Note, application parameters and information to reload data are not saved. The save sessions facility 
is designed for this purpose.

Figure 4.17. Saving and Loading Chart Configurations

.....
 
The images in the figure above show how you can load a chart configuration.

The first image shows a chart configuration with ten charts. In this example the user has clicked the Load 
push button which pops up a file selector dialog. Here an alternative chart configuration XML file was 
selected which changes the chart area by adding another chart named "Coloured Inversion". The second 
image shows the chart area has been updated with another chart which, in this case, was used to display 
Coloured Inversion spectra. At any time you can use the "Chart Controller" dialog to save a specific 
chart configuration to an XML file for future use in this or other projects.

4.2.2.5. Changing the Number of Columns

The chart area is divided into columns. The number of columns parameter allows you to control the number 
of charts that can be displayed in a chart row. This can range from 1 up to 30. The table below gives you 
an example of how this parameter is used.

Figure 4.18. Changing the Number of Columns
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The images in the figure above show how the various charts can be laid out within the central chart area of 
the main window. The parameter which controls the number of columns can be found in the Chart 
Controller dialog. This dialog can be popped up by either clicking on the menu item View->Chart Controller... 

or clicking the  icon.

The Chart Controller dialog above shows the Number of Columns parameter set to 2 which would cause the 
central chart area of the SciQt main window to appear like the chart area on the left (ie two columns of 
charts). The RH image shows the central chart area with one column of charts (ie the Number of 
Columns parameter set to 1).

4.2.2.6. Zooming In and Zooming Out

The Zoom In and Zoom Out push buttons perform the same functions as those described in the section 
entitled Global Zooming

4.2.3. Display Options

The Display Options dialog allows you to control what data is displayed in a given chart. The Display Options 
dialog will also allow you to change some chart properties including: Title (can also do this on the Chart 
Controller), the labels on the X Axis and Y Axis and Line Thickness. Currently, Line Thickness parameter 
controls the thickness of every data item on the chart. It is not possible to change the Line Thickness of 
an individual data item. The Display Options dialog can be popped up by clicking the Edit push button on the 
Chart Controller dialog or by MB3 on the chart and selecting from the pop up menu Display Data Items...

Figure 4.19. Display Options dialog
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The sub-sections below describe the various tasks that can be performed from within the Display Options dialog.

4.2.3.1. Chart

Changing chart titles, axes names and line thickness via the Display Data Items dialog is very simple.

Figure 4.20. Changing Chart Properties

 
The figure above shows how you can change title, x axis label, y axis label and line thickness.

In this example we have changed the title, the x axis label and y axis label together with the line thickness of 
data items displayed on this chart. As we edit these fields the SciQt main window is updated in real time.
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4.2.3.2. Management of Data Items

This is a very powerful feature which allows you to specify what data is to be displayed on a given chart.

Figure 4.21. Management of Data Items

 
The figure above shows how you add and remove data items to a chart. Data items are assigned data label 
names and are grouped together into logical sets. The set (or group) name, together with the data label 
name, uniquely identifies the data item. So, for example, in the "Trace Spectra" group the trace spectra data 
items are given names of the form "TRACE_<counter>" where counter is in the range "001" to "999". So, the 
first trace spectrum would be assigned a label "TRACE_001" with the second trace spectrum 
assigned "TRACE_002" and so on. Similar names are assigned to "Raw Trace" and "Gated Trace" groups.

Now data items can be added to a chart by selecting the group name and the data label name within. The 
image above shows the "Display Data Items" dialog with the "Data Item" list displaying the "group names" 
and optionally the "data label name" if the group is open (ie expanded). Groups can be expanded or collapsed 
by clicking to the left of the group name. So, once a data item is selected for a chart, whenever that data item 
is available it will be displayed on that chart.

In the image above where we have selected the data item labelled "TRACE_003 within the "Trace Spectra" 
group. Notice that displayed the "TRACE_003" spectrum is now displayed (black line on the "Coloured 
Inversion operator" chart). If we now clear the traces via the "Select Input Data Dialog" and reload more 
seismic traces we will get a new trace labelled "TRACE_003" displayed on the "Coloured Inversion Operator" 
chart. This persistence is a useful feature of the underlying, rule based, chart control system.

At the time you select a data item for display you can assign a colour. Alternatively, you can allow a colour to 
be assigned automatically.

Prev Up  Next

4.1. Interfacing with the SciQt Application Home  4.3. Select Input Data
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4.3. Select Input Data

4.3.1. Input Seismic tab

This section describes how to select the input seismic trace data for use in the Coloured Inversion operator 
design. Coloured Inversion requires that you select a predetermined number of seismic traces from the full 
3D survey area or sub-area, determined by the user. Trace selection is random within the area. Our aim is to 
select a set of traces which is representative of the 3D Survey Area for which we are trying to derive a 
Coloured Inversion operator. With the data selected it will normally be necessary to constrain it in some 
manner. The sub-section below describes how you can select and constrain the trace data.

4.3.1.1. Select trace data

This section provides a Select Sesimic... button which will allow you to pop-up a seismic selector dialog. 
This section also allows you to specify the 3D Survey Area to be used to retrieve trace data for Coloured 
Inversion analysis.

Figure 4.22. Select Input Data dialog (Input Seismic tab)

 
The figure above shows the top portion of the Input Seismic tab where seismic data volume has been pre-
selected. This is the recommended method when running SciQt as an OpendTect plug-in. Whilst it is 
highly recommended, it is not necessary to pre-select the input "stored cube" via the OpendTect "Attribute 
Set" dialog prior to launching the SciQt plug-in. If the selected seismic is not pre-selected then you can 
always select the "stored cube" by clicking the Select Seismic... button.

With the seismic data selected, it is usually desirable to define a sub-area. This is achieved by clicking the 
Sub button from the 3D Survey Area radio button group. Following this, the user would specify the sub-area 
using the Start In-line, End In-line, Start X-line and End X-line edit boxes. Finally, the number of traces is 
specified and the Load Seismic button is clicked.

4.3.1.2. Loading and Clearing Data

With the seismic data volume selected you can now load a set of traces to be analysed. Here you can 
optionally choose to select traces from the full 3D survey area or sub 3D survey area. This is achieved using the 
3D Survey Area radio button group as follows:

1.  Full for the complete area
2.  Sub for setting the In-line and X-line Start and End values for a sub-area

Typically you would select a single sub-area. Specifying a sub-area in this manner enables you to include an 
area of the survey where the trace data is known to be of good quality and is representative of the survey area 
as a whole. With sub-area selected it is simply a case of specifying the number of traces to load (default 40) 
via the Num. Traces spinbox widget. This is then followed by you clicking the Load Seismic button to load 
a random set of traces. A list of the randomly loaded traces is then displayed in the Input tab beneath the 
Load Seismic button. At the same time an alternative set of traces is also loaded. These alternative traces are 
listed in the QC tab and are used with the derived Coloured Inversion operator for QC purposes. The software 
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also enables you to select trace data from multiple sub-areas. This is achieved by specifying another In-line/X-
line Start and End range and clicking the Load Seismic button again. The goal is to generate seismic trace 
spectra which is a good representation of the area as a whole. If you attempt to specify an area which is outside 
of the available area then a warning message will be issued when you attempt to load seismic traces by 
clicking the Load Seismic button. You will also get an error message if you set an area which would not 
allow enough unique traces for the Num. Traces requested.

Figure 4.23. Loading Seismic Data

 
The image in the figure above shows the SciQt Main Window with Select Input Data Dialog superimposed. 
The Raw Seismic spectra resulting from clicking the Load Seismic button on the "Select Input Data 
Dialog" (above left) with Num. Traces set to 40 and a 3D Survey Area is defined by:

In-line: 1400 - 1800

X-line: 4300 - 5400

By default, all loaded traces are used in the spectra calculation and contribute to the Seismic Mean 
Spectrum. However, you can remove a given trace from the SciQt analysis by deselecting it via the Input 
list. Deselection of a trace is simply achieved by unchecking the checkbox within the list. If you want to 
completely remove the deselected trace you click the Clear Unselected Traces button. Alongside each trace on 
the Input list, are various properties associated with the trace. These include Trace Id (or trace label), In-line, 
X-line, RMS Amp, RMS Err, Horz Time. The RMS Amp property is derived from the input seismic trace, whereas 
the RMS Err property is derived from the trace spectrum. The latter can be considered as a "goodness of 
fit" parameter as it compares trace spectrum with the smooth mean trace spectrum. So for RMS Err, the 
smaller the number the better the fit. Loaded traces, by default, are sorted by Trace Id. However, you can sort 
the list of traces using one of the other properties. This is easily achieved by clicking the column header on 
the Input list. So, for example, if you want to sort by RMS Amp in ascending order, you click the RMS Amp 
header label. To sort in descending order you click the RMS Amp header label again. You can also change 
the position of the property columns. This is simply achieved by clicking and holding on a property header 
then dragging the property header to its new position.

The image shows the result of clicking the Load Seismic push button. Here 40 traces have been randomly 
loaded and immediately displayed in the "Raw Seismic" chart within the SciQt Main Window. Also visible is 
a portion of the "Select Input Data Dialog" showing the trace list on the "Input" tab sorted by ascending 
RMS Amplitude values.

Figure 4.24. Clearing Seismic Data
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The image in the figure above shows the result of clicking the Clear Lists push button. Clear list removes all 
traces previously loaded to memory and has the immediate effect of removing this data from the "Raw 
Seismic" chart within the SciQt Main Window.

4.3.1.3. Modifying Time Range

Specifying the time range (gate) is an important step. Ideally, you should choose a time gate in the range of 500 
- 1000 msec which should be over the zone of interest. You can set the Time Range mode in one of three ways 
via the "Range" radio button.

1.  Full - this range would cover the full trace length. It is rarely used
2.  Sub - here you additionally need to specify Absolute Start Time and Absolute End Time. This Time Range mode 

is the default.
3.  Horizon - here you additionally need to specify the Relative Start Time and Relative End Time. You also need to 

specify the horizon to be used.

Of the three options the Horizon Range mode is the preferred mode since it allows the gate to follow the 
geology and should, with a well interpreted horizon in the target zone give, in theory, trace spectra which are 
more closely matched.

Figure 4.25. Modifying Seismic Time Range (Full)

 
The image in the figure above shows the SciQt Main Window with Select Input Data Dialog superimposed. 
Here, "Full" (full trace range) has been selected for the Range radio button. This mode is rarely used since our 
goal is to design a Coloured Inversion operator over the zone of interest. This will optimise the process over 
that zone. However, it does allow you, although insensitive, to see the start and end times of the entire trace.

Figure 4.26. Modifying Seismic Time Range (Sub)
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The image in the figure above shows the SciQt Main Window with Select Input Data Dialog superimposed. 
Here, "Sub" (sub trace range) has been selected for the Range radio button. In this mode the Absolute Start 
time and the Absolute End time Line Edit fields will be sensitised. This allows you to specify a time gate for 
the zone of interest. Typically, you would specify a time gate which has a time range between 500msec 
and 1000msec.

Figure 4.27. Modifying Seismic Time Range (Horizon)

 
The image in the figure above shows the SciQt Main Window with Select Input Data Dialog superimposed. 
Here, "Horizon" (horizon relative trace range) has been selected for the Range radio button. In this mode 
the Relative Start time and the Relative End time Line Edit fields will be sensitised. This allows you to specify a 
time gate for the zone of interest. Typically you would specify a time gate which would give you a time 
range between 500msec and 1000msec. Specifying the Start and End times here are relative to a geologic 
horizon. A negative number represents time above the horizon whereas a positive number is a time below 
the horizon. The time gate can be either above, below or span the horizon.

4.3.1.4. Removing Bad Traces

Occasionally, it is necessary to remove one or more poor spectral traces which contribute to the generation of 
the mean spectra. This is easily achieved by identifying problem spectral traces from the chart and 
deselecting these traces from within the Select Input Data Dialog.

Figure 4.28. Removing Bad Traces
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If one or more seismic trace spectra displayed on the Raw Seismic plot were anomalous then it is possible 
to remove those traces from the Seismic Mean Spectrum calculation.

Let us consider the blue trace (which appears to have a particularly low amp (dB) at around 60Hz). Now, if 
we wish to exclude this trace from the mean calculation, we must first identify it. This is achieved by pointing 
close to one of the vertexes of this spectrum and clicking on it. We need to be within few a pixels of one 
of vertexes to be able to identify it. If we are within range when we click then the spectra named, together 
with the Frequency and Amplitude of the vertex, is displayed in the Status Area of the Main Window. In this 
case, the raw seismic spectra is identified as "TRACE_003". We can now to go to the Input Trace list and click 
the checkbox to the left of entry "TRACE_003". This causes the trace to be flagged as not currently selected 
and the Raw Seismic plot on the Main Window is updated accordingly. The Seismic Mean spectrum (black) on 
both displays changes as a consequence. An alternative method, which works well in this case, is to look at 
the RMS Err property. You will note that the RMS Err of TRACE_003 is significantly larger than that of the RMS 
Err values of the other trace spectra. So, if you sort by RMS Err, you will easily be able to identify any trace 
spectra with an abnormally large RMS Err value. You should note that once you toggled off a trace, it may loose 
its RMS Err value as the spectrum is not calculated.

4.3.1.5. Select Volume dialog

The Select Volume dialog provides you with a 3D seismic volume selector. From here simply select the 
seismic volume you require for your SciQt analysis and operator design. A volume filter is provided to reduce 
the list to a manageable size for projects with many volumes.

Figure 4.29. Select Volume
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...

 
The images in the figure above show examples of the "Select Volume" dialog for selection of a seismic volume. 
The LH image shows a seismic volume list without a seismic volume filter. The RH image shows the use of a 
filter to create a shorter list. As can be seen, the wild card character (*) can be used in the Filter field.

4.3.1.6. Horizon Input Dialog

The Horizon Input Dialog provides you with a horizon selector. From the Horizon Data tab, simply select 
the horizon you require for your SciQt analysis and operator design. A Horizon filter is provided to reduce the list 
to a manageable size for projects with many horizons.

Figure 4.30. Select Horizon

...

 
The images in the figure above show examples of the "Select Horizon" dialog for selection of a seismic 
horizon. The LH image shows a seismic horizon list without a horizon list filter. The RH image shows the use of 
a filter to create a shorter list. As can be seen, the wild card character (*) can be used in the Filter field.

4.3.2. Input Well Log tab

This section describes how to select the input well log Acoustic Impedance data for use in the Coloured 
Inversion operator design. Coloured Inversion requires that you select one or more Acoustic Impedance logs 
from those available for the project. Ideally we would like to generate AI spectra from multiple well logs as 
this should help to retrieve a better global spectrum to curve fit. However, data from the different wells might 
be of variable quality so it is up to you to decide which wells to use. The figure below shows the Input Well Log 
tab on the Select Input Data Dialog.

Figure 4.31. Select Input Data Dialog - Input Well Log tab
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In the above dialog the large central area is to display and control the selection of Well Log Acoustic 
Impedance data. It consists of the following fields: Field/Well/Logs, Top, Base, Common Well Nm, UWI, 
Remark, In-line, X-line, Horz Time and Horz Src. These fields can be moved by grabbing (click and hold) the 
field header and dragging to a new position. Clicking on the field headers sorts the list according to the data in 
that field. The Field/Wells/Logs provides a facility to expand and contract the entire list. Additionally, this 
field allows Acoustic Impedance data to be selected and deselected.

The sub-sections below describes how you can select and constrain the data.

4.3.2.1. ASCII well log loading

Loading Acoustic Impedance data from ASCII is straightforward. Simply click on the Load ASCII Wells... 
push button to pop up a file selector. Within the File Selector you can traverse the file system to locate 
Acoustic Impedance data in ASCII format. The File Selector allows one or more ASCII files to be open at once. 
Use the <Shift> key modifier to select consecutive files and the <Ctrl> key modifier to select non-consecutive 
files from within the File Selector dialog. You can also MB1 and drag the mouse over a number of ASCII files.

Figure 4.32. ASCII Well Log Selection
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The picture in the figure above shows the Input Well Log tab, where well log data has been loaded. In this 
case the well log data was loaded from ASCII files. The central list area shows four impedance curves have 
been loaded. One each for four wells. Normally, well log ASCII data files do not contain inline, xline or 
horizon data. So, in such cases, it is not possible to select a time range relative to an interpreted horizon. 
However, SciQt recognises certain XML style meta tags, which can be used by you to provide additional 
data. Below are the five XML style meta tags recognised by SciQt.

<inline>inline data here</inline>

<xline>xline data here</xline>

<horztime>horizon time data here</horztime>

<xcoord>x coordinate here</xcoord>

<ycoord>y coordinate here</ycoord>

These XML meta tags are normally inserted on one line within the ASCII file. For example, in Landmark style 
ASCII files these would normally be placed on the second line (which is blank). It is not necessary to include all 
the meta tags. Normally, only the <inline> and <xline> meta tags are supplied as there is then 
sufficient information for horizon data to be extracted from the supplied horizon. In this example, the 
horizon information for well_4.dat, well_3.dat and well_3.dat can be obtained from the supplied horizon (Horz 
Scr = horz) using the In-line and X-line data supplied via the meta tags <inline> and <xline>. For well_1.
dat however, the horizon information comes from the <horztime> meta tag (Horz Scr = well) since no In-line or 
X-line data has been supplied.

4.3.2.2. Define ASCII File Format

This section describes how you can define the format for ASCII file reading of well AI log data. Clicking the 
Define Format... push button will pop up the "Define ASCII File Format" dialog.

Figure 4.33. Define ASCII File Format
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The figure above shows the "Define ASCII File Format" dialog. This dialog has three groups: "Select ASCII 
Format", "Record and Column Information" and "File Time Column Units".

Select ASCII Format: This group contains a radio button with two options Landmark ASCII and User defined. 
In Landmark ASCII mode (default) the other two groups are desensitised. In User defined mode you can 
supply additional information in the "Record and Column Information" and "File Time Column Units" 
groups. Although no explicit LAS input facility is provided, you can normally read LAS files in User defined mode.

Record and Column Information: If your ASCII has header records before the wireline curve data you should 
skip these by specifying a value in the No. of Recs to Skip input field. You should also specify which column 
the time data and the impedance data can be found. By default, these are set to 1 and 2 respectively.

File Time Column Units: This radio button item allows you to specify whether the time data is in milleseconds 
or seconds.

4.3.2.3. Database well log loading

Loading acoustic impedance data from OpendTect database is straightforward. The details are explained in 
the table beneath. Essentially, you click the Load Wells push button which will auto select all the 
acoustic impedance log curves in the OpendTect data repository.

Figure 4.34. Database Well Log Loading

....

 
The two images in the figure above show the top portion of the Input Well Log tab used to load OpendTect 
well log AI data. The left image shows the state when the "Input Well Logs" tab is first selected by you 
following display of the "Select Input Data" dialog.

Click the Load Wells push button which will auto select all the acoustic impedance log curves in the 
OpendTect data repository. It is assumed that acoustic impedance logs will have the characters "AI" (upper 
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or lower case) or "IMP" (upper or lower case) somewhere within the log curve name. If, for a given well, there 
are no such AI log curves or the log curve doesn't meet the assumed naming convention, then the user can 
still select or generate AI log curves manually.

The image to the right above shows, in the central area, that two AI log curves, one each from two wells, 
have been automatically loaded. In OpendTect, log curves are stored in depth. Coloured Inversion requires the 
AI log curves to be in time. During the loading process the AI data which is stored in depth within OpendTect 
is depth to time converted using the associated time-depth model associated with a given well. It is 
then resampled to be regular in time. The sample interval used for this purpose can be changed via the 
"Advanced Controls" dialog, "Time domain" tab.

We can also manually select or generate AI well log. This is achieved by right clicking on well name which will 
pop-up a menu with Select AI Log... and Generate AI Log... menu items. Selecting the first item will pop-up 
the "Select Database Logs" dialog which lists the available logs allowing you to choose an AI log curve however 
it's named. Selecting the second item will pop-up the "Generate AI Log" dialog which displays two lists. The 
left hand list allows you to select a sonic log with right hand list allowing you to optionally select a density log. 
If no density is available, then you can select User for Density Source radio button and supplying a User 
Density Value. Here the AI log will be generated from the supplied sonic and density.

The push buttons Clear Wells and Clear Unselected Wells are self explanatory. Note the Load Wells push button 
will change to a Reload Wells push button after the initial automatic selection.

4.3.2.3.1. Select Database Logs dialog

This dialog allows you to select the Acoustic Impedance Well Log data that is to be used from the OpendTect 
data repository. The figure below shows the "Select Database Logs" dialog in OpendTect.

Figure 4.35. Select Database Logs (OpendTect)

 
This dialog provides a wild card filter field which operates on the list of logs to provide a facility to shorten the 
list of logs to a manageable size should this be necessary.

4.3.2.3.2. Generate AI Log dialog

This dialog allows you to generate an Acoustic Impedance Well Log curve from the sonic and optionally, 
density logs that are stored in the OpendTect data repository. The figure below shows the "Generate AI 
Log" dialog in OpendTect.

Figure 4.36. Generate AI Log (OpendTect)
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This dialog provides wild card filter fields which operate on the two list of logs to provide a facility to shorten 
the list of logs to a manageable size should this be necessary. If no density log is available then you can supply 
a constant density value. This is achieved by clicking on User for the Density Source radio button and 
specifying the density value in the User Density value field.

4.3.2.4. Modifying Time Range

Specifying the time range (gate) is an important step. Ideally, you should choose a time gate in the range of 500 
- 1000 msec which should be over the zone of interest. You can set the Time Range mode in one of three ways 
via the "Range" radio button.

1.  Full - this range would cover the full trace length. It is rarely used.
2.  Sub - here you additionally need to specify Absolute Start Time and Absolute End Time. This Time Range mode 

is the default.
3.  Horizon - here you additionally need to specify the Relative Start Time and Relative End Time. You also need to 

specify the horizon to be used.

Of the three options the Horizon Range mode is the preferred mode since it allows the gate to follow the geology.

Figure 4.37. Modify Well Log Time Range (Full)

 
The image in the figure above shows the SciQt Main Window with Select Input Data Dialog superimposed. 
Here, "Full" (full trace range) has been selected for the Range radio button. This mode is rarely used since our 
goal is to design a Coloured Inversion operator over the zone of interest. This will optimise the process over 
that zone. However, it does allow you, although insensitive, to see the start and end times of the entire trace.
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Figure 4.38. Modify Well Log Time Range (Sub)

 
The image in the figure above shows the SciQt Main Window with Select Input Data Dialog superimposed. 
Here, "Sub" (sub trace range) has been selected for the Range radio button. In this mode the Absolute Start 
time and the Absolute End time Line Edit fields will be sensitised. This allows you to specify a time gate for 
the zone of interest. Typically, you would specify a time gate which has a time range between 500msec 
and 1000msec.

Figure 4.39. Modify Well Log Time Range (Horizon)

 
The image in the figure above shows the SciQt Main Window with Select Input Data Dialog superimposed. 
Here, "Horizon" (horizon relative trace range) has been selected for the Range radio button. In this mode 
the Relative Start time and the Relative End time Line Edit fields will be sensitised. This allows you to specify a 
time gate for the zone of interest. Typically, you would specify a time gate which would give you a time 
range between 500msec and 1000msec. Specifying the Start and End times here are relative to a geologic 
horizon. A negative number represents time above the horizon whereas a positive number is a time below 
the horizon. The time gate can be either above, below or span the horizon. Clicking the Select Horizon... 
push button will pop up the Horizon Input Dialog.
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4.2. User interaction with Chart Area Home  4.4. Design Controls

http://opendtect.org/rel/doc/arkcls/sci/ch04s03.html (12 of 12) [21-10-2009 15:30:19]



4.4. Design Controls

4.4. Design Controls
Prev Chapter 4. User Manual  Next

4.4. Design Controls

This section describes how you can tweak various parameters to improve the Coloured 
Inversion operator.

Figure 4.40. Design Controls Dialog

 
SciQt is data driven, so once the data is identified and loaded then a Coloured Inversion 
operator will immediately be available for saving. This makes the Coloured Inversion 
analysis very easy for the end user. However, the resulting operator may not be optimum. 
Therefore, it will frequently be necessary to perturb various design parameters to produce 
the optimum Coloured Inversion operator. The various charts within the main window are 
used to help you produce the ideal Coloured Inversion operator for your data. Below is a 
description of the primary parameters used to design the Coloured Inversion operator. 
Additional parameters can be found under the "Advanced Controls" dialog which can be 

popped up via the Tools->Advanced Controls... menu item or via the  icon

The Design Controls dialog is split into three groups: Smooth Seismic Mean, Fit Well Log 
Curves and Design Controls. The following three sections describe these groups.

4.4.1. Smooth Seismic Mean
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Figure 4.41. Smooth Seismic Mean

 
The only parameter in this group is the Smooth Operator Len (Hz). This spinbox controls 
the length of the smoothing operator used in the smooth mean algorithm that is applied to 
the seismic mean spectrum. It has a range of 1 - 1/5th nyquist and by default it is set to a 
value of 1/25th nyquist. View the chart named "Seismic Mean" whilst changing the value in 
the spinbox to see the effect of this parameter. The aim here is to iron out high frequency 
amplitude variations as we are only interested in the global shape of the seismic spectrum. 
The image in the figure above shows the smooth mean spectrum (black) overlaying the 
mean spectrum (red). Here the Smoothing Operator Len is set at 10Hz.

4.4.2. Fit Well Log Curves

Figure 4.42. Fit Well Log Curves block
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Full Range: This checkbox item allow you to control whether curve fitting is performed on 
the full range. The spinbox controls in this group are the primary parameters used for 
principal curve fitting.

1.  Full Range checkbox (checked) - default on the distributed template

In this mode, curve-fitting is performed on the global spectrum and will be 
performed on the "Full Range". The Low Cut and High Cut for Fit Well Log Curves 
will be desensitised.

2.  Full Range checkbox (unchecked)

In this mode, curve fitting consists of three curves "Below Principal", Principal" and 
"Above Principal". The intersection between the "Below Principal" and the "Principal" 
curves is at the "Low Cut" point. The intersection of the "Principal" and "Above 
Principal" curves is at the "High Cut" point. The "Low Cut" spinbox is the Min Fit 
Frequency of the principal curve and the "High Cut" spinbox is the Max Fit 
Frequency of the principal curve. The other curves outside this range are generated 
in accordance with the controls on the "Frequency Domain" tab on the "Advanced 
Controls" dialog.

Low Cut: This spin box allows you to specify the minimum frequency that the curve 
fit algorithm will attempt to fit for the principal curve. By default, this is set to zero 
Hz. However, if including lower frequencies is not of any concern to you or you wish 
to additionally use a low frequency curve or linear horizontal low frequency section, 
then setting this to a higher value can often result in a better curve fit over the 
frequency range of interest.
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High Cut: This spin box allows you to specify the maximum frequency that the 
curve fit algorithm will attempt to fit for the principal curve. By default, this is set to 
the nyquist frequency. However, if including higher frequencies is not of any 
concern to you or you wish to additionally use a high frequency curve or linear 
horizontal high frequency section, then setting this to a lower value can often result 
in a better curve fit over the frequency range of interest.

Curve fitting is updated immediately the "Low Cut" control, "High Cut" control or the 
"Frequency Domain" controls on the "Advanced Controls" dialog are changed. In this 
case we have defaulted the Low Cut to zero Hz and have set the high cut to 90Hz. 
The Above Principal curve fit is horizontal.

At any time you can curve fit to the full spectrum 0 Hz - nyquist by toggling on the 
"Full Range" checkbox within the "Fit Well Log Curves" group.

4.4.3. Design Operator

Figure 4.43. Design Operator block
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The "Design Operator" group provides controls which allow you to perturb how the 
Coloured Inversion operator spectrum is generated. Specifically, it allows you to adjust the 
bandwidth of the designed operator. Normally, the default is that the bandwidth is 
automatically calculated. The "Design Operator" chart displays three spectra. The first 
spectrum is the band limited curve fit (green curve), the second spectrum is the smooth 
seismic mean (red curve) and the third spectrum is the Coloured Inversion operator (blue 
curve).

Auto Calc.: The top checkbox controls whether the "Low Cut" and "High Cut" (i.e. design 
operator bandwidth) values are automatically calculated.

1.  Top Auto Calc. checkbox (checked) - default on the distributed template

In this mode the design operator bandwidth is automatically calculated
2.  Top Auto Calc. checkbox (unchecked)

In this mode you can manually set the "Low Cut" and "High Cut" spinboxes.

Low Cut: this control will be sensitised allowing you to adjust the low cut to optimise 
the Coloured Inversion operator. Using the "Residual Operator (QC)" chart will help. 
The objective here is that the residual operator should be essentially flat and 
centred around 0 dB within the bandwidth.

High Cut: this control will be sensitised allowing you to adjust the high cut to 
optimise the Coloured Inversion operator. Using the "Residual Operator (QC)" chart 
will help. As with the Low Cut, the objective is that, the residual operator should be 
essentially flat and centred around 0 dB within the bandwidth.

Auto Calc.: The middle checkbox allows you to control the slopes on the derived operator. 
This checkbox is only sensitised if you are manually setting the design operator "Low Cut" 
and "High Cut" (i.e. the top Auto Calc checkbox is unchecked).

1.  Middle Auto Calc. checkbox (checked) - default on the distributed template

In this mode, the -60 dB down point is at 0 Hz on the low size with the -60 dB down 
point 30 Hz above the High Cut value on the high side.

2.  Middle Auto Calc. checkbox (unchecked)

In this mode you can manually specify the frequency of the -60 dB down point both 
on the low and high sides.

Auto Calc.: The bottom checkbox controls whether the "Num. Zero X-ings" (i.e. time 
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domain operator truncation) value is automatically or manually calculated.

1.  Bottom Auto Calc. checkbox (checked) - default on the distributed template

In this mode, the truncation of the time domain Coloured Inversion operator will be 
automatically determined. This is controlled by a parameter which sets the 
percentage of energy captured. The percentage of energy captured template 
parameter is currently set at 99.9%. It is planned that future versions of SciQt will 
allow you to set template (default) parameters. It is sometimes desirable to alter the 
amount of truncation applied in order to reduce the length of long tails of very small 
sample values or to include additional samples of significant value.

2.  Bottom Auto Calc. checkbox (unchecked)

In this mode, the Num. Zero X-ings spinbox must be set manually. This allows you 
to adjust the length of the time domain operator in steps of zero crossings. It is 
desirable to have the operator truncate to a sample point close to a zero crossings 
point as it reduces anonymous side effects which might be introduced when the 
operator is applied. A read only field to the right displays the % Energy captured as 
you adjust the number of zero crossings.

QC Against Input Seismic: This checkbox control, if checked, allows you to perform the QC 
against the original set of random seismic traces instead of the alternative set of random 
seismic traces.

1.  QC Against Input Seismic checkbox (unchecked) - default on the distributed template

In this mode, the calculation of the Coloured Inversion operator is performed using 
the original set of random seismic trace (listed on Select Input Data dialog -> Input 
Seismic tab -> Input tab). The QC of the Coloured Inversion operator is performed 
on the alternative set of random seismic traces (listed on Select Input Data dialog -
> Input Seismic tab -> QC tab).

2.  QC Against Input Seismic checkbox (checked)

In this mode, the calculation of the Coloured Inversion operator is again performed 
using the original set of random seismic trace (listed on Select Input Data dialog -> 
Input Seismic tab -> Input tab). However, the QC of the Coloured Inversion 
operator is performed on the same set of random seismic traces (listed on Select 
Input Data dialog -> Input Seismic tab -> Input tab).

Prev Up  Next

4.3. Select Input Data Home  4.5. Advanced Controls
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4.5. Advanced Controls
Prev Chapter 4. User Manual  

4.5. Advanced Controls

This section describes the advanced control parameters which can be used with SciQt.

The advance controls in SciQt allow you to modify various secondary parameters. These secondary 
parameters have been grouped together under the "Frequency Domain" tab, "Design Operator" tab 
and "Time Domain" tab. The following three sections describe these groups.

4.5.1. Frequency Domain

Figure 4.44. Frequency Domain Tab

 
The "Frequency Domain" tab provides you with control over the curve fitting mechanism. By default, 
curve fitting is only performed between the "Low Cut" and the "High Cut" frequencies (the primary 
controls) which are defined in the "Fit Well Log Curves" group on the "Design Controls" dialog. This 
curve fit is referred to as the "Principle" curve. Below the "Low Cut" and above the "High Cut" we 
force the curve fit to horizontal, with the value of the "Principle" at the "Low Cut" and "High Cut" 
points.

Whilst using these advance controls it is advisable to QC the resulting curve fit by always having the 
spectrum you are trying to fit and the composite curve fit visible on one of the SciQt Main Window 
charts (by default the "Global" chart). Immediately you make a change to one or more of the 
"Frequency Domain" parameters you will see the change on your Main Window chart. Note, it might 
not be possible to QC against a spectrum if no well data is available. Under such circumstances you 
would need to supply the curve fit parameters manually or read them from file.

Within the "Curve Fitting" group there is a matrix of "Alpha" "DC" and "F-Shift" for "Below principal", 
"principal" and "Above principal" curves. For each curve there is a combo control to the right which 
specifies the mode of curve fit. We will now consider each of these three curves and describe their 
mode of use.
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Below principal: The default mode is "Force Horizontal". In this mode, the "Alpha", "DC" and "F-
Shift" are insensitive and cannot be used. The "DC" value displayed is the value of the "Principal" 
curve fit at the "Low Cut" point. The "Fit Independently" mode uses the same curve fit algorithm 
between 0 Hz and "Low Cut" as that used for the "Principal" curve fit. The displayed "Alpha", "DC" 
and "F-Shift" are parameters from the independent fit. This mode frequently gives strange results 
and its usage is not normally recommended. The "Extrapolate Principall" mode allows the 
"Principal" curve to be extrapolated, below the "Low Cut", back to 0 Hz. The "Set" mode allows you 
to manually set the sensitive "Alpha", "DC" and "F-Shift" of the "Below principal" curve. However, 
the "Set" mode is not normally recommended.

Principal: The "principal" curve is by far the most important curve hence its name. The default 
mode is "Curve Fit". Curve fitting is performed between the "Low Cut" and the "High Cut" 
frequencies defined in the "Fit Well Log Curves" group on the "Design Controls" dialog. The "Alpha" 
is the key curve fit parameter and is also displayed on the "Design Controls" dialog. The "Set" mode 
allows you to manually set the sensitive "Alpha", "DC" and "F-Shift" of the "Principal" curve.

Above principal: The default mode is "Force Horizontal". In this mode the "Alpha", "DC" and "F-
Shift" are insensitive and cannot be used. The "DC" value displayed is the value of the "Principal" 
curve fit at the "High Cut" point. The "Fit Independently" mode uses the same curve fit algorithm 
between "High Cut" and nyquist as that used for the "Principal" curve fit. The displayed "Alpha", 
"DC" and "F-Shift" are parameters from the independent fit. This mode frequently gives strange 
results and its usage is not normally recommended. The "Extrapolate Principal" mode allows the 
"Principal" curve to be extrapolated beyond the "High Cut" up to nyquist. The "Set" mode allows 
you to manually set the sensitive "Alpha", "DC" and "F-Shift" of the "Above principal" curve. 
However, the "Set" mode is not normally recommend.

There are two other "Advanced Controls" on the "Frequency Domain" tab "Type of Fit" and 
"Set From File...". The following described these controls:

Type of Fit: This radio button control allows you to select the type of fit algorithm. Possible values 
are "Least Squares" or "Robust". By default, the type of fit is "Least Squares".

Set From File...: This push button will pop up a file selector dialog allowing you to read a previously 
saved session file to load the "Alpha", "DC", "F-Shift", curve fit "Low Cut" and curve fit "High Cut". If 
there is a session file associated with this SciQt run either via "File->Open..." or "File->Save As..." 
then that session file will be the default. You can also use this mechanism to load the above 
parameters from Coloured Inversion V2.3.x saved files. However, it should be noted that it is not 
possible to load from SciQt V2.90 session files as these parameters were not saved in that version. 
This option is useful when no well data is available or you wish to use the same curve fit parameters 
from a previously saved session.

4.5.2. Design Operator

Figure 4.45. Design Operator Tab
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There is currently only one parameter in this group. The "Set Operator Energy = 1" checkbox item is 
here for backward compatibility with earlier versions of the Coloured Inversion software. This 
checkbox item allows the time-converted operator to be normalised. With this turned on, the 
amplitude values are adjusted so that the energy in the time converted operator is set to one.

4.5.3. Time Domain

Figure 4.46. Time Domain Tab

 
This group is split into the sub-groups "Data Conditioning" and "Log Data Resampling".

Sub-group: Data Conditioning
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For the coloured inversion result to have amplitudes which have physical meaning, then it will be 
necessary to normalise the AI log spectral amplitude. This is achieved by compensating for the 
effects of the relative differences between the seismic and AI log gate lengths together with the 
relative differences between the seismic and AI log sample intervals.

Normalisation

Normalise: This checkbox item allows you to toggle on/off the normalisation facility.

Interval Source: This radio button control allows you to specify whether the Sample Interval or 
Design Gate is determined from Seismic or User. If the source is Seismic then the normalisation 
parameters are obtained from the sample interval and gate length of the seismic data. If the source 
is User then you need to additionally provide the Nominal Seismic Sample Interval (ms) and Nominal 
Seismic Design Gate (ms) see below.

Nominal Seismic Sample Interval (ms): This spinbox control allows you to specify the nominal seismic 
sample interval to be used for normalisation purposes. This control is active if User is set for the 
"Interval Source" radio button above.

Nominal Seismic Design Gate (ms): This line edit field allows you to specify the nominal seismic 
design gate length to be used for normalisation purposes. This control is active if User is set for the 
"Interval Source" radio button above.

Remove Linear Trend from Log Data

Detrend: This checkbox item allows you to turn on the de-trend facility. Here the linear trend within 
the AI Log can be removed before the generation of amplitude spectra. The figure below shows on 
the LH plot the de-trend lines on the input log data. The RH plot shows the same logs after linear 
trend has been removed and application of ramp (see Ramp Ends of Log Using Papoulis Windowing 
below).

Figure 4.47. Effect of Detrending

.....

 
Ramp Ends of Log Using Papoulis Windowing

Apply Ramps: This checkbox item allows you to turn on the apply ramps facility. This allows the ends 

http://opendtect.org/rel/doc/arkcls/sci/ch04s05.html (4 of 5) [21-10-2009 15:30:25]



4.5. Advanced Controls

of the input AI Log data to be ramped.

Ramp Length (ms): This input field value allows you to specify the ramp length in milliseconds.

Log Data Resampling

Interval Source: This radio button allows you to select the source log data resampling.

1.  Seismic

This radio button option specifies that the log data resampling will be to the same sample 
interval as the seismic. The "Resampling Interval" spinbox is desensitised.

2.  User

This radio button option allows you to specify the log resampling interval in the sensitised 
"Resampling Interval" spinbox.

Resampling Interval:This spinbox allows you to specify the resampling interval.

Prev Up  

4.4. Design Controls Home  
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